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Supertree and Sensitivity
Software

Why Software is Useful __________________________________________

Analyzing large trees by hand is tedious and prohibitively time consuming.
Imagine a tree with five nodes, each with three branches. There are 35 =
243 paths through this tree. First you would have to draw the tree, then you
would have to obtain the 243 values to place at the end of each path for the
value measure, and then you would have to perform the roll-back or roll-
forward to obtain the expected value of the tree. Probability distribution
graphs would need to be created from these data. And any changes in input
data would require repeating all the calculations.

Thus, to use decision analysis successfully and routinely, a computer
is essential. Three tasks are required of the computer:

• Calculate the value used for the value measure. In today’s
business world, this value is usually calculated by a spread-
sheet.

• Iterate the calculation and record the results for all the paths
through the decision tree.

• Perform the decision analysis tasks such as tree roll-back,
plotting the probability distribution, displaying the evaluated
tree, obtaining value of information and control, and the like.

In this document, we will show how the twin programs Sensitivity (for
deterministic sensitivity analysis as described in Chapter 6) and Super-
tree (for probability and decision tree analysis) can be used to evaluate the
examples used in this book.

To obtain a student version of these programs, go to the website
www.supertree.net.

In the first instance of the use of any of the Supertree or Sensitivity
functions, the user interface will be completely displayed and reference
made to the relevant sections of the book. In subsequent uses of a function,
only important features of the user interface will be referred to.
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2 COMPUTER SETUP

Computer Setup ________________________________________________

Supertree and Sensitivity are two separate programs intended for use on a
personal computer. They require a PC running Windows 95 or later with a
minimum of 8 megabytes of RAM and 3 megabytes of free space on the hard
disk.

To start a Supertree or Sensitivity session, go to the Programs option in
the Start menu of Windows. Choose the folder Supertree 95 and either the
Supertree or Sensitivity icon.

Each program has a Help menu which accesses a complete description
of the program’s features.

Positronics (Chapter 2) __________________________________________

Figure 2–9 is a completed probability tree for the first pass analysis of the
Positronics case. To analyze this tree, we will enter it into the Supertree
program.

To prepare the tree for entry into Supertree, it is necessary to make
some modifications, as shown in Figure A–1. The following four elements
have been added to the tree to make it suitable for entering into Supertree:

• A new type of node has been added—the endpoint node (shown
as a à). This is the node Supertree uses to assign a value to a
scenario or path through the tree. Usually this node corre-
sponds to a deterministic node in the influence diagram—
Profit, in the Positronics case. All paths through the tree must
terminate on the right in an endpoint node.

• The nodes have been numbered. Here, Anode’s bid is node
number 1, Positronics’ cost is node number 2, and the endpoint
node is node number 3. Node numbers in Supertree must be
positive integers. Making the numbers increase from left to
right in the tree helps you remember the structure while
analyzing the tree.

• Each chance node has been given a node name, AnodeBid and
Cost. In Supertree, the node name not only describes the node,
but is also a variable that takes on as a value the outcomes of
the node. Thus, the node names are variables that can be used
by the endpoint node (value model) to calculate a value for each
path through the tree. For instance, Supertree will give the
variable Cost a value of 200, 400, or 600 depending on the path
through the tree being evaluated. Node names in Supertree
must begin with a letter and be composed of letters, digits and
the underscore (_) character.

• A reward of $0 has been assigned to each branch of the chance
nodes and appears to the right of the outcomes on the branches.
(In hand-drawn trees, they usually appear under the branches.)
Rewards are quantities added to the values at the endpoints



SUPERTREE AND SENSITIVITY SOFTWARE 3

and are a quick way to represent the benefits (costs if negative)
associated with a particular branch. By convention, rewards
are normally not shown explicitly when they are zero.

In Supertree, you build the tree node by node, using the Input or Change
Node Data option from the Structure menu. Supertree will first ask you for
a descriptive name to be used in labeling output; enter* Positronics Tree #1.
Supertree then asks you for the number of the node (enter 1) and the type
of the node (enter Chance). Use the mouse or the Tab key to move from field
to field to enter the data for the node as shown in Figure A–2. Click OK,
Next… to enter the information for node 2 as shown in Figure A–2.

You need only type the first few letters of many entries in Supertree.
When you press the Tab key or click on another entry field, Supertree will
complete the entry for you. For instance, when entering the type of node, you
could type c and Supertree would fill out the full Chance entry when you went
to another field. If you are in doubt as to the possible entries in a field, enter
a question mark (?).

Figure A–1

Positronics Tree Ready for Entry into Supertree

*User entry for computer dialog boxes will be shown in italics.
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4 POSITRONICS (CHAPTER 2)

Figure A–2

Entry Screens for AnodeBid, Cost , and Profit Node
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Before entering node 3 (the endpoint node), we need to decide how to use
the endpoint to place values at the end of the tree. We could type in numbers
directly, but this works only for very small trees. In this case, we will use
Supertree’s capability for evaluating an endpoint expression using Basic
syntax. We can use numbers, operators, and node name variables in this
expression. (Use Supertree’s Help menu and refer to the Basic Interface
topic for details.)

The equation for profit was shown in the Profit node (Figure 2–8). The
proposed bid is $500,000, and the value is (500 – Cost) if Positronics wins
the bid. So, we could write the endpoint as follows:

(500 – Cost) (A–1)
However, what happens when Anode bids less than Positronics? Positron-

ics loses the bid and does not get the profit described in Equation A–1. To
model this, we can use a programmer’s trick. In Basic (and in other
programming languages), we can write a relational expression that com-
pares two values with such operators as < (less than), = (equal to), <= (less
than or equal to), etc. The result of this operation is either “true” (with a
result of 1) or “false” (with a result of 0).*

We can describe whether or not Positronics wins the bid with the
expression (500 < AnodeBid). This expression is true (equals 1) if AnodeBid
is greater than 500 and false (equals 0) if AnodeBid is less than or equal to
500. If we multiply (500 – Cost) by this expression, we will zero out profits in
the cases where Positronics loses the bid. Putting these together in a single
expression, we obtain:

(500 – Cost) * (500 < AnodeBid) (A–2)
This expression will yield the profit values shown before. The last

information needed for node 3 is that it depends on nodes 1 and 2, which
means it needs the values of the variables AnodeBid (node 1) and Cost (node
2) to calculate values. This information was already in the influence
diagram (Figure 2–5) in which the Profit node was influenced by the Anode
Bid node and by the Positronics Cost node. “Depends on” in Supertree is the
same as “is influenced by” in influence diagram language.

We can now enter node 3 into Supertree. Use the Input or Change Node
Data command from the Structure menu, enter 3 for the node number and
Endpoint for the node type. Enter Basic for the name of the program—the
entry Basic indicates that an expression will be entered in Basic syntax.
Enter the data as in Figure A–2. At the bottom of the dialog box, Supertree
will display its summary of the endpoint expression—the B records the fact
that Basic syntax is used and the $ separates the B from the formula.

Once we have entered the structure of the tree, it must be evaluated
by choosing the Evaluate Tree option from the Evaluate menu. The
Evaluate Tree option uses the endpoint node(s) to find the values associated
with each path through the tree. While this task is trivial in this case, for

*In almost every computing language, true is equal to 1. In Basic, true is equal to -1.
Supertree violates this Basic rule by taking true equal to 1 in Basic syntax expression.
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Figure A–3

Plotting a Cumulative Distribution
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trees with hundreds or thousands of paths and for models that take many
seconds to run, evaluation is a major, time-consuming task.

Before evaluating the tree, Supertree checks that the structure and
input are consistent and sensible (from a computer’s point of view). Howev-
er, Supertree gives the user considerable latitude in describing the tree and
using endpoints; as a result, we could enter a tree and model that cause
Supertree to encounter an error during the evaluation, resulting in an error
message.

Analyzing the Tree: Now that the tree has been evaluated, we will
determine what information can be drawn from it. First, we will examine
how the component uncertainties have translated into uncertainty on the
value of ultimate interest to the decision-maker. If we go to the Analyze
menu of Supertree and choose the Plot Distribution option, Supertree will
ask for information to specify the plot desired (Figure A–3).

We will leave the order of nodes the same for now by pressing the Tab
key without entering anything in the field (we will see the usefulness of
node reordering later) and then enter 1 for the node at which to plot the
probability distribution. This will cause the overall probability distribution
for the entire tree to be displayed. Select a cumulative plot and a single
distribution. (Multiple distributions show the individual distributions at
each branch of the selected node.) Enter Profit ($000) for the label for the axis.

When we are through we click the OK button to process the information.
Supertree then displays the smallest and largest values in the distribution,
suggested limits for the plot, and other plot specifications. We can accept
these by clicking the OK button or we can enter other specifications, as
shown in Figure A–3. The resulting plot appears at the bottom of Figure A–
3.

Using the Histogram choice of the Plot Distribution option from the
Analyze menu is another way to represent the probability distribution for
the venture’s value. In a histogram plot, the horizontal (value) axis is divided
into a number of equal-sized ranges or bins. The height of the bar drawn for
each bin is the probability (vertical axis) that the value falls in the bin. For
Supertree, a value is in a bin if it is greater than or equal to the lower bound
of the bin and less than the upper bound of the bin (less than or equal to for
the rightmost bin). The input data for the histogram (Figure A–4) are similar
to those for the cumulative plot.

We can see the rollback process through the Display Tree option of the
Analyze menu. The data entry screen for the Display Tree option appears in
Figure A–5. As in Plot Distribution, Supertree asks for the order of nodes and
then requests the number of the first and last nodes to be drawn. For very
large trees, drawing the whole tree takes a prohibitive amount of time and
computer memory and would add little, if any, insight. Finally, Supertree
asks whether we wish scale the drawing.

If all we wished to see was the expected value of the tree, we could
choose the Rollback Tree option from the Analyze menu and see the results
in Figure A–6.
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Figure A–4

Plotting a Histogram
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Figure A–5

Displaying the Tree
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Figure A–6

Rolling Back the Tree

Expected Value: 65                                              
Tree Rollback  Positronics Tree #1                                              
Expected Value: 65                                              
Tree Rollback  Positronics Tree #1                                              



10 POSITRONICS (CHAPTER 3)

Figure A–7

Positronics Tree with Decision
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Figure A–11

Tree Data—Tabular Form

Figure A–10

Tree Data—Schematic Tree
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Positronics (Chapter 3) __________________________________________

We have already done most of the work to prepare the Positronics tree with
decisions for input to Supertree. The schematic tree has been created
(Figure 3–4). Now we need to number the nodes. We will stay with our
practice of having node numbers increase from left to right in the tree
(Figure A–7).

To modify our existing tree (Figure A–1) in Supertree, we first need to
renumber the existing nodes to make room for the new node 1; Anode’s bid
was originally node number 1. We could enter all the data for the tree.
However, if we have saved the tree entered in the previous section, we can
use the Open option of the File menu to retrieve the data. We can then use
the Change Tree Name option and the Renumber Node option from the
Structure menu, as shown in Figure A–8.

We can now enter the decision node as node 1. Use the Input or Change
Node Data option from the Structure menu. Supertree will first ask you for
the number of the node (enter 1) and the type of the node (enter Decision).
Then enter the data as in Figure A–9. The main differences from the dialog
box for chance nodes is the lack of a column for probabilities and the lack
of a field for dependent probabilities. We have given the decision node the
name Bid and can use this variable in the endpoint model. Note that the
number of branches has been changed to 4 and that the bottom branch goes
to a new successor node, 5.
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Figure A–12

10/50/90 Bars for Positronics' Alternatives

POSITRONICS (CHAPTER 3)
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The Input or Change Node Data option has been used to modify node 4
to have the value

(Bid – Cost) * (Bid < AnodeBid) (A–3)
and to depend on nodes 1, 2, and 3. A new endpoint node with Value as the
name of program and value 0 was also created.

The Show Schematic Tree option of the Structure menu shows all this data
as a schematic tree (Figure A–10), and the Show Tree Structure option of the
Structure menu shows the input data in tabular form (Figure A–11).

Because the structure and endpoint model have been changed, we must
Evaluate the tree again.

Analyzing the Tree: Selecting multiple rather than single plots under the
Plot Distribution option of the Analyze menu, we obtain the probability
distribution for all the alternative bid decisions (Figure 3–6). The staircase
appearance is a result of the discrete approximation used in constructing the
tree. If more branches had been used, the curves would be smoother and the
plot easier to read.

An alternative representation of the probability distributions can be
obtained by using the 10/50/90 bars feature of Plot Probability Distribution,
as shown in Figure A–12. The bars show the 10, 50, and 90 percentiles of the
distribution for each alternative for Bid and the line goes from the minimum
to the maximum of the distributions; an asterisk (*) marks the expected
value. Some decision makers relate best to this simplified format.

The default decision criterion in Supertree is to maximize the expected
value of the values given at the endpoints. Hence, we can use the Rollback
option of the Analyze menu to find the expected value of the tree to be
$65,000. This expected value is the value of the preferred alternative—in
this case, the $500,000 alternative.

We can also use the Display option of the Analyze menu to see the whole
of this small tree (Figure A–13). Note the > to indicate the chosen alternative
is to bid $500,000.

For large trees, it is impractical to display the entire tree to find out
which scenarios lead to which values. Often, however, it is interesting to find
a scenario that leads to a given value—either because the value is suspect
or because we need a representative scenario to explain the results. The
Trace Value in Tree option of the Analyze menu performs this task for you
(Figure A–14). Of course, the task is trivial in a tree as simple as this.

The Sensitivity to Probability option of the Analyze menu performs
probabilistic sensitivity analysis (also known as stochastic sensitivity anal-
ysis) as shown in Figure 3–8. As indicated in Figure A–15, the horizontal axis
is the probability assigned to the first (top) branch of node 3; the rest of the
probability is assigned to the bottom branch, and the middle branch is given
zero probability. This two-branch approximation is used for ease of interpre-
tation. If the probability at node 3 depended on another node, that dependency
would have been overridden in this option.

Value of Perfect Information conceptually involves evaluation of the
large tree shown in Figure 3–10. However, Supertree provides a simpler
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Figure A–13

Decision Tree for Positronics

POSITRONICS (CHAPTER 3)

approach by evaluating the subtree shown in Figure 3–12. Use the Rollback
Tree option, give the new order of nodes as 2 1 3 and find that the expected
value of the subtree is $95,000. The new order of nodes specified in the
Rollback Tree option puts node 2 (Anode Bid) before node 1 (Positronics Bid).

The Rollback Tree option with node order 3 1 2 can be used to show that
the value of the venture with (not of) perfect information on Positronics’ cost
is $85,000 (Figure 3–13).

Finally, the Rollback Tree option with node order 2 3 1 can be used to
show that the value of the venture with perfect information on both AnodeBid
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Figure  A–14

Tracing Value in Tree

and Positron’cs’ Cost is $116,250.
The subtree displayed in Figure 3–12 can be obtained by the Display Tree

option with the order of nodes 2 1 3 and 2 3 the first and last nodes to be
displayed (Figure A–16).

Positronics (Chapter 4) __________________________________________

It is easy to input dependent probabilities in Supertree. If the tree from the
previous section is open, clear the tree by using the New option of the File
menu; if you have just opened Supertree, there is nothing to be cleared. We
are clearing the old data out because we will put the nodes in a different order,
as shown in Figure 4–2. Supertree could deal with the nodes in the order we
originally entered them, but for the beginner, it is less confusing to reenter
the tree.

Use the Input or Change Node Data option from the Structure menu and
enter Bid as node 1, Cost as node 2, and AnodeBid as node 3. Make the
probabilities for AnodeBid depend on Cost, node 2. Click on the Enter button
in the Probability column and, in the large dialog box that appears, enter the
data shown on the Show Schematic Tree option output in Figure A–17.

Analyzing the Tree: Since we have reentered the tree, we need to Evaluate
it again before analyzing it. (This would not be necessary if we had only
changed the probabilities.) After evaluating, go to the Plot Distribution option
of the Analyze menu and plot the cumulative distribution (Figure 4–3).

The distributions for the two cases (independent and dependent proba-
bilities) can be plotted on the same graph by using the Store Distribution and
Recall Distribution options of the File menu. Store Distribution is used to
store on disk the distributions associated with any particular tree, either for
use with external programs or for use with the Recall Distribution option. The
Recall Distribution option can be used to plot stored distributions on the same
graph.

Figure A–18 illustrates a feature common to Store Distribution, Plot
Distribution, Display Tree, and List Distribution Values. The distribution at

Value traced: 500                                               

The closest value is:  500                                      

Bid=700; AnodeBid=800; Cost=200                                                  

Value traced: 500                                               

The closest value is:  500                                      

Bid=700; AnodeBid=800; Cost=200                                                  
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Figure A–15

Sensitivity to Probability of Anode's Bid Being $200,000

POSITRONICS (CHAPTER 4)
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Figure A–16

Tree with Perfect Information on Anode's Bid
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node 2 has been chosen as the node at which the distribution is desired.
Because this node is not the first node, a new entry field appears asking for
the branches to be chosen for the previous nodes. In Figure A–18, the
distribution corresponding to Bid=500 has been chosen, and the distribution
corresponding to that alternative is saved to disk.

The data can be recalled using the Recall Distribution option. Figure A–
19 shows two dialog boxes used by Recall Distribution; between these two
dialog boxes, the standard Windows dialog for opening files has been used to
choose two files. On closing the second dialog box, the probability distribu-
tions contained in these two files will be plotted.

 Having dependent outcomes is another way of representing probabilis-
tic dependence for continuous variables. Entering dependent outcomes in
Supertree is easy. Supertree even allows both dependent outcomes and
dependent probabilities for a node (though it would take an unusual problem
to need them both). Using the Input or Change Node Data option for node 3
( this option is used to change nodes as well as add them), enter a blank for
“Probabilities depend on nodes” and a 2 for “Outcomes depend on nodes”; then
reenter the original probabilities. Click on the Enter button in the Outcome

Figure A–17

Entering Dependent Probabilities
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Figure A–18

Storing the Probability Distribution for Bid=500, Dependent Probabilities

Figure A–19

Recalling the Probability Distributions for Bid=500, First and Last Dialog Boxes
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Figure A–20

Entering Dependent Outcomes

column and, in the large dialog box that appears, enter the data shown on the
Show Schematic Tree option output in Figure A–20.

We could then try the Plot Distribution option of the Analyze menu.
However, if we did try, Supertree would inform us that we have made changes
that require running the Evaluate Tree option again. We have the option of
using the old data, which might be desirable if we had made a change and
then decided to change back to the original data. Supertree would have no
way of knowing that there had been no net change. In this case, we want to
use the Evaluate Tree option and then Plot the distribution (Figure A–22).

Nature’s Tree—Letting Supertree Do the Work: Reversing trees by hand is
a tedious and error-prone process. Supertree can perform the calculations
automatically. The tree in Figure 4–12 can be entered into Supertree, as
shown in Figure A–21a. The Show Schematic Tree information for this tree
is shown. Since we are not really interested in values here, we have entered
a Value endpoint node with value 0.
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Figure A–21

Prototype Information

Before analyzing the tree, we still have to use the Evaluate Tree option.
We can then use Display Tree to examine the tree in its original order
(Figure A–21b), confirming that we have entered the data correctly.

We can use the Display Tree option to show the tree with the nodes
reversed (2 1 rather than 1 2) (Figure A–21c). We now see the probability for
the various Positronics costs, given, for instance, that the prototype turned
out to be inexpensive.

The Value of Imperfect Information: One of the most important uses of
Bayes’ Rule and Nature’s tree is in obtaining the value of imperfect
information. If we obtain imperfect information, we know the outcome of
the imperfect indicator before we make a decision—and before we learn the
true state of nature. This order requires reversing Nature’s tree.

Note the difficulty in dealing with the probabilities in the tree shown in
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Figure A–22

Prototype Tree

Figure 4–15. If we need to change any of the input probabilities for Prototype
Cost or Positronics’ Cost, we would have the flip the tree (Figures 4–16 and
4–17) to obtain the new set of probabilities for the tree. However, there is a
simpler way—we will let Supertree do the work for us.

We can do this by adding the node on Prototype Cost onto the front of the
original tree (Figure 4–18) and by then comparing the new tree’s value with
that of the original tree (Figure 3–7). After renumbering and adding the new
node, we obtain the Show Schematic tree display in Figure A–22. Note that
Supertree allows you to input the probabilities in the Nature’s tree order.

We then need to Evaluate the tree before using the Display Tree option
to display a tree like that shown in Figure 4–18.

When reordering the tree, Supertree sometimes produces puzzling
messages or results. These messages or results are normally concerned
with decision-dependent probabilities, decision-dependent outcomes, or
rewards.

Decision-Dependent Probabilities: Probabilities can depend on a decision
node. For instance, the probabilities for Positronics’ costs could depend on
which branch of a cost control decision node we were on (Figure 4–19).
Suppose we now decide to move the cost node in front of the cost control
decision node in the decision tree. As discussed in Chapter 4, this is not
allowed.

If we were to analyze a tree of this sort with the nodes in the improper
order, Supertree would report an error, “Decision dependent probabilities
prevent tree evaluation in this order.”

 Decision-Dependent Outcomes: For chance nodes whose outcomes de-
pend on a decision node, we would expect the same problem as with decision-
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dependent probabilities. After all, dependent probabilities and dependent
outcomes are both ways of characterizing dependent probability distribu-
tions. However, as discussed in Chapter 4, there is an interpretation of
dependent outcomes that allows us to interchange the nodes, and Supertree
assumes we intend this interpretation.

The interpretation is that we learn whether we are on the high branch,
the middle branch, or the low branch (assuming there are three branches)
before we make the decision. We do not know the value of the outcome, only
whether we are on the top branch, the second branch, or the third branch.

 Whenever a node with dependent outcomes occurs before its condition-
ing node, the outcomes are shown in the Display Tree option as asterisks.
There is no way to show the outcome values in a tree display in this order
because they depend on a node that comes afterwards. However, all calcula-
tions are done with the correct combinations of outcome values because
Supertree keeps track of which outcomes are associated with which scenar-
ios (tree paths) regardless of how the nodes are reordered for display purposes.

Rewards: Supertree gives us the option of figuring the rewards into the
endpoints or of keeping rewards at the node and figuring them into the values
at that point. This makes a difference in the results of the Display Tree option
(and the Plot Distribution option, if you are plotting a distribution at a node
other than the first node in the tree).

In moving a node with rewards, there are two ways to interpret the
reordering. First, we could be rearranging the order of events that make up
the tree, in which case the rewards should move with the node to the new
order. Second, we could be performing a value of information calculation, in
which case the rewards should stay where they are and be incurred when the
event happens, rather then when you get information on it. (Recall that node
reordering is a shortcut to obtain the value of information.)

An unexpected effect can arise when nodes are reordered in an asym-
metric tree with rewards. The reordering can force Supertree to put the tree
into a more symmetric form. With this symmetrization, figuring in rewards
at the nodes can cause surprising changes to endpoint values. These
changes occur because figuring in rewards at a node may mean adding the
node (and its rewards) on a path in the symmetrized tree where it was not

Figure A–23

Setting Risk Tolerance
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Figure A–24

Sensitivity to Risk Tolerance
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present in the original asymmetric tree. To keep the net value the same,
Supertree must also subtract the reward from the endpoint value for that
path, resulting in the unexpected endpoint values. The net change in the
value of the scenarios (tree paths) is zero.

Positronics (Chapter 5) __________________________________________

Supertree has the exponential utility function built in. Using the Set Risk
Attitude option of the Analyze menu, we set the risk tolerance to $1 million
(Figure A–23). (A frequent error involves using different units for risk
tolerance and for values.)

We can then use the Display Tree option to draw the tree in Figure 5–
13. The other options of the Analyze menu also now show certain equiva-
lents when appropriate, with decisions in the tree being made to maximize
the certain equivalent.

Supertree has an automatic way of performing sensitivity analysis to
risk attitude. The results from selecting the Sensitivity to Risk option from
the Analyze menu are shown in Figures 5 –17 and A–24. The horizontal axis
is linear in 1/risk tolerance, which is the risk-aversion coefficient. The
leftmost values are for infinite risk tolerance, which is equivalent to the
expected value. The certain equivalents are then plotted for each alterna-
tive for each value of the risk tolerance.

Diagnostics (Chapter 6) __________________________________________

The Diagnostics example in Chapter 6 begins with a spreadsheet which
performs a deterministic evaluation of the alternatives. This is similar to
the way most real-world analyses evolve: begin by understanding the
complexity of the problem, then add the complexity of uncertainty.

To understand the use of the Supertree and Sensitivity software, it is
first necessary to understand how the spreadsheet was constructed.

The input section for Diagnostics’ spreadsheet is shown in Figure 6–8
and A–25. The rows in the Alternative Table describe the components of
each of the three alternatives. The Input table contains the values for the
analysis, and the values used by the calculations are contained in cells
C11:C62; the range names in cells D11:D62 are applied to these cells by
selecting cells C11:D62 and using the Excel command Insert/Name/
Create. The R&D Investment input is given in cells E65:O67 (zero values in
cells I65:O67 are not displayed in Figure A–25); the range names in cells
D65:D67 are applied to these rows by selecting cells D65:O67 and using the
Excel command Insert/Name/Create.  Finally, cells B9:H62 isselected and
assigned the name RD_InputTable by using the Excel commmand Insert/
Name/Define; this range name will be used shortly.

The calculations section for Diagnostics’ spreadsheet is shown in
Figures 6–9 and A–26. Cell A3 contains the formula
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A B C D E F G H
1 Alternative Table DiagRF DiagStatic
2 # Name Device Target Price Device Comp. Adv. Graphics Target Price
3 1 Milk Exisiting Products Current $20,000 Current Features OEM $10,000
4 2 DiagRF Plus Upgrade $25,000 Current Features OEM $15,000
5 3 DiagStatic New Current $20,000 New Link+ Features Integral $10,000
6
8 INPUT
9 Description In Use Range Name Low Base High Units
10 Alternative 3 Alternative 1, 2, 3

11
12 Market
13 Total market, 2000 3,500 Mkt_00 3,500 units/year

14 Total Market, 2010 4,500 Mkt_10 4,000 4,500 5,000 units/year

15 RF Fraction of Market, 2000 17% Mkt_RF_fr_00 17% percent

16 RF Fraction of Market, 2010 25% Mkt_RF_fr_10 20% 25% 35% percent

17 DiagStatic
18 DiagStatic, Market Share, 2000 10% MS_00_DSt 10% percent

19 DiagStat ic, Market Share growth rate -20% MS_gr_DSt -25% -20% -15% percent

20 DiagStatic, Year Discontinued 2005 Yr_DSt_stop 2005 year

21      If DiagStatic New is introduced before this year, DiagStatic is discontinued at that time

22 DiagStatic, Price, 2000 $9,500 ASP_00_DSt $9,500 $/unit

23 DiagStatic, Price CAGR 0% ASP_gr_DSt -5% -1% 1% percent

24 DiagStatic COGS, 2000 $4,500 COGS_00_DSt $4,500 $/unit

25 DiagStatic, COGS CAGR 2% COGS_gr_DSt 0% 2% 3% percent

26 DiagStatic New
27 DiagStat ic New, Technical Success Yes tech_succ_DStn No Yes Yes yes/no

28 DiagStatic New, Start Year 2003 Startyr_DStn 2003 year
29 DiagStatic New, Years to Peak 3 Yrs_to_pk_DStn 3 years

30 DiagStat ic New, Years at Peak 8 Yrs_at_pk_DStn 8 years

31 DiagStatic New, Years from Peak to 0 7 Yrs_to_0_DStn 7 years

32 DiagStatic New, Market Share at Peak 20% MS_pk_DStn 10% 20% 40% percent

33 DiagStatic New, Price, start  year $14,000 ASP_sy_DStn $12,000 $14,000 $15,000 $/unit

34 DiagStat ic New, Price CAGR 0% ASP_gr_DStn -3% 0% 1% percent

35 DiagStatic New, COGS, start year $4,800 COGS_sy_DStn $4,600 $4,800 $5,200 $/unit

36 DiagStatic New, COGS CAGR 2% COGS_gr_DStn 0% 2% 3% percent

37 DiagRF
38 DiagRF, Market Share, 2000 40% MS_00_DRF 40% year

39 DiagRF, Market Share growth rate -10% MS_gr_DRF -20% -10% -5% percent

40 DiagRF, Year Discontinued 2008 Yr_DRF_stop 2008 year

41      If DiagRF Plus is introduced before this year, DiagRF is discontinued at that time

42 DiagRF, Price, 2000 $17,000 ASP_00_DRF $17,000 $/unit

43 DiagRF, Price CAGR 0% ASP_gr_DRF -4% 0% 1% percent

44 DiagRF, COGS, 2000 $4,500 COGS_00_DRF $4,500 $/unit

45 DiagRF, COGS CAGR 2% COGS_gr_DRF 0% 2% 3% percent

46 DiagRF Plus
47 DiagRF Plus, Start Year 2001 Startyr_DRFp 2001 year
48 DiagRF Plus, Years to Peak 2 Yrs_to_pk_DRFp 2 years

49 DiagRF Plus, Years at Peak 6 Yrs_at_pk_DRFp 6 years

50 DiagRF Plus, Years from Peak to 0 5 Yrs_to_0_DRFp 5 years

51 DiagRF Plus, Market share at Peak 40% MS_pk_DRFp 25% 40% 45% percent

52 DiagRF Plus, Price, start  year $19,000 ASP_sy_DRFp $17,000 $19,000 $23,000 $/unit

53 DiagRF Plus, Price CAGR 0% ASP_gr_DRFp -3% 0% 1% percent

54 DiagRF Plus, COGS, start  year $4,800 COGS_sy_DRFp $4,600 4,800 $5,300 $/unit

55 DiagRF Plus, COGS CAGR 2% COGS_gr_DRFp 0% 2% 3% percent

56 GLOBAL VARIABLES
57 Base Year 2000 BaseYear 2000 year
58 Discount Rate 10% DiscountRate 10% percent
59 Tax Rate 38% TaxRate 38% percent
60 Sales, General, Administrative 10% SGA 10% % of unit sales
61 Working Capital, 1999 $3,000,000 Wcap_99 $3,000,000 $

62 Working Capital 29% Wcap 29% % of revenue

63

64 R&D Investment ($000) 2000 2,001 2002 2003
65 DiagRF Plus RD_DRFp 500 1,500
66 DiagStat ic New, pre-success RD_pre_DStn 1,800 1,800
67 DiagStat ic New, post-success RD_post_DStn 400 1,900 1,100

Figure A–25

Input Section for Diagnostics’ Spreadsheet
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A B C D E F G H I J K L M N O P
1 Alternative DiagRF DiagStatic
2 # Name Device Target Price Device Comp. Adv. Graphics Target Price
3 3 DiagStatic New Current $20,000 New Link+Features Integral $10,000
4
5 1999 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 Year

6 Market Units Sold
7 Static 2,905 2,950 2,996 3,042 3,088 3,135 3,182 3,230 3,278 3,326 3,375 c_Mkt_Static

8 RF 595 639 685 732 782 833 887 943 1,001 1,062 1,125 c_Mkt_RF

9
10 Diagnostics' Units Sold
11 DiagStatic 291 236 192 156 0 0 0 0 0 0 0 c_units_static

12 DiagStatic New 0 0 0 0 206 418 636 646 656 665 675 c_units_static_new

13 DiagRF 238 230 222 214 205 197 189 180 172 0 0 c_units_rf

14 DiagRF Plus 0 0 0 0 0 0 0 0 0 0 0 c_units_rf_plus

15
16 Revenue ($000)
17 DiagStatic 2,760 2,242 1,821 1,480 0 0 0 0 0 0 0 c_rev_static

18 DiagStatic New 0 0 0 0 2,882 5,852 8,911 9,044 9,178 9,314 9,450 c_rev_static_new

19 DiagRF 4,046 3,910 3,771 3,630 3,488 3,346 3,206 3,067 2,931 0 0 c_rev_rf

20 DiagRF Plus 0 0 0 0 0 0 0 0 0 0 0 c_rev_rf_plus

21
22 Cost of Goods Sold ($000)
23 DiagStatic 1,307 1,083 898 744 0 0 0 0 0 0 0 c_cogs_static

24 DiagStatic New 0 0 0 0 1,008 2,088 3,242 3,356 3,474 3,596 3,722 c_cogs_static_new

25 DiagRF 1,071 1,056 1,038 1,020 999 978 956 933 909 0 0 c_cogs_rf

26 DiagRF Plus 0 0 0 0 0 0 0 0 0 0 0 c_cogs_rf_new

27
28 Financial Results ($000)
29 Revenue 6,806 6,152 5,592 5,109 6,370 9,199 12,117 12,112 12,110 9,314 9,450

30 Costs 2,378 2,139 1,936 1,763 2,007 3,066 4,198 4,289 4,384 3,596 3,722

31 Gross Margin 4,428 4,013 3,656 3,346 4,363 6,133 7,919 7,822 7,726 5,718 5,728

32
33 SG&A 681 615 559 511 637 920 1,212 1,211 1,211 931 945

34 R&D Expense 1,800 2,200 1,900 1,100 0 0 0 0 0 0 0

35
36 EBIT 1,947 1,198 1,197 1,735 3,726 5,213 6,707 6,611 6,515 4,786 4,783

37 Tax 740 455 455 659 1,416 1,981 2,549 2,512 2,476 1,819 1,818

38 Earnings 1,207 743 742 1,076 2,310 3,232 4,159 4,099 4,039 2,967 2,966

39
40 Working Capital 3,000 1,974 1,784 1,622 1,482 1,847 2,668 3,514 3,512 3,512 2,701 2,741

41 Change in Working Capital -1,026 -190 -162 -140 366 820 846 -2 -1 -811 40

42
43 Cash Flow 2,233 932 904 1,216 1,944 2,412 3,312 4,101 4,040 3,778 2,926

44 Cumulative Cash Flow 2,233 3,166 4,070 5,286 7,230 9,642 12,954 17,055 21,095 24,873 27,799

45 PV Cash Flow 2,233 847 747 913 1,328 1,498 1,870 2,104 1,885 1,602 1,128

46 Cumulative PV Cash Flow 2,233 3,081 3,828 4,742 6,070 7,567 9,437 11,541 13,426 15,028 16,156

47
48 NPV ($ million)
49 Cash Flow 2000-2010 16

50 Terminal Value 10

51 Total 27 NPV

Figure A–26

Calculations Section for Diagnostics’ Spreadsheet

A3:=INDEX(Input!A4:A6, Alternative)

(A3: is not part of the formula) and this formula is copied over to other cells
in the row to show the components of the alternative chosen in the cell
Alternative. Formulas for the cells in E7:E51 are shown below; the formulas
in cells E7:E46 are copied across into the cells F7:046.  Range names for
some of the rows are given in column P.

E7:=Mkt_00*((Mkt_10/Mkt_00)^(0.1*(Year-BaseYear)))*(1-(Mkt_RF_fr_00
+(Year-BaseYear)*((Mkt_RF_fr_10-Mkt_RF_fr_00)/10)))
E8:=Mkt_00*((Mkt_10/Mkt_00)^(0.1*(Year-BaseYear)))*((Mkt_RF_fr_00
+(Year-BaseYear)*((Mkt_RF_fr_10-Mkt_RF_fr_00)/10)))
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In the previous two equations , the 10 year time horizon has been written
explicitly into the equations (.1 and 10) as an example of bad practice. If the
expert had preferred to give values in 2008 rather than 2010, the facilitator
would have had to search out all instances of the use of this factor of 10.

E:11=c_Mkt_Static*MS_00_DSt*(1+MS_gr_DSt)^(Year-BaseYear)*
(Year<=Yr_DSt_stop)*(c_units_static_new=0)
E12:=c_Mkt_Static*MS_pk_DStn*MAX(0,MIN(1,(Year-Startyr_DStn)/
Yrs_to_pk_DStn))*MAX(0,MIN(1,1-(1+Year-Startyr_DStn-Yrs_to_pk_DStn-
Yrs_at_pk_DStn)/Yrs_to_0_DStn))*(3=Alternative)*(“yes”=tech_succ_DStn)
E13:=c_Mkt_RF*MS_00_DRF*(1+MS_gr_DRF)^(Year-BaseYear)*
(Year<=Yr_DRF_stop)*(c_units_rf_plus=0)
E14:=c_Mkt_RF*MS_pk_DRFp*MAX(0,MIN(1,(Year-Startyr_DRFp)/
Yrs_to_pk_DRFp))*MAX(0,MIN(1,1-(1+Year-Startyr_DRFp-Yrs_to_pk_DRFp-
Yrs_at_pk_DRFp)/Yrs_to_0_DRFp))*(2=Alternative)

The terms involving MAX and MIN in cells E12 and E14 implement the
market share model shown in Figure 6–6.

E17:=ASP_00_DSt*(1+ASP_gr_DSt)^(Year-BaseYear)*c_units_static/1000
E18 :=ASP_sy_DStn* (1+ASP_g r _DStn )^ (Yea r -S ta r t y r _DStn ) *
c_units_static_new/1000
E19:=ASP_00_DRF*(1+ASP_gr_DRF)^(Year-BaseYear)*c_units_rf/1000
E20:=ASP_sy_DRFp*(1+ASP_gr_DRFp)^(Year-Startyr_DRFp)*c_units_rf_plus/
1000

E23:=COGS_00_DSt*(1+COGS_gr_DSt)^(Year-BaseYear)*c_units_static/1000
E24:=COGS_sy_DStn*(1+COGS_gr_DStn)^(Year-Startyr_DStn)*
c_units_static_new/1000
E25:=COGS_00_DRF*(1+COGS_gr_DRF)^(Year-BaseYear)*c_units_rf/1000
E26:=COGS_sy_DRFp*(1+COGS_gr_DRFp)^(Year-Startyr_DRFp)*
c_units_rf_plus/1000

E29:=SUM(E17:E20)
E30:=SUM(E23:E26)
E31:=E29-E30

E33:=SGA*SUM(E17:E20)
E34:=RD_DRFp*(Alternative=2)+(Alternative=3)*(RD_pre_DStn+RD_post_DStn*
("yes"=tech_succ_DStn))

E36:=E31-E33-E34
E37:=E36*TaxRate
E38:=E36-E37

E40:=Wcap*E29
E41:=E40-D40
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E43:=E38-E41
E44:=E43+D44
E45:=E43/(1+DiscountRate)^(Year-BaseYear)
E46:=E45+D46

E49:=O46/1000
E50:=0.001*(O38/DiscountRate)/((1+DiscountRate)^11)
E51:=E49+E50

Finally, the entry in cell D40 is =Wcap_99/1000.

Sensitivity Analysis: Choose Sensitivity from Start/Supertree 95. From
the Structure menu, choose Import Variable Data as in Figure A–27. This
step is possible only with an Excel spreadsheet; for other programs, the data
must be entered manually. After the first of the screens asking for the range
name of the area containing the data, you will be asked to locate the
spreadsheet (not shown in Figure A–27) and for the remaining information
shown in Figure A–27.

Figure A–27

Importing Variable Data from Diagnostics’ Spreadsheet
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Figure A–28

Input of Single Variable Sensitivity Data

At this point, choose Import or Change Single Variable Data from the
Structure menu and add the data shown in Figure A–28. This is a useful
trick. Although there is no variation in this variable, it will set the
alternative to be used in the sensitivity.

The dialog box shown in Figure A–28 is used to input or modify sensitivity
data. The one entry that needs explanation is Variation type, which can be
Value (the Low and High result values are substituted for the Base value),
Additive (the Low and High result values are added to the Base value), or
Multiplicative (the Base value is multiplied by the Low and High results).

The data that has been input can be shown by choosing Show Sensitivity
Data from the Structure menu (Figure A–29). This data was imported from
the spreadsheet or input as shown in Figures A–27 and A–28. The status of
new in the final column indicates that all the variables have just been
entered; the status will change to old once Sensitivity uses the spreadsheet
to evaluate the sensitivity to that variable. At the bottom of the data shown
in Figure A–29 are several default options for the handling of the Excel
spreadsheet. These options can be modified by choosing Enter or Change
Model from the Structure menu and clicking the Options button.

As with Supertree, you must choose Evaluate Sensitivity from the
Evaluate menu. This causes Sensitivity to instruct Excel to run all the cases.

The display shown in Figure 6–10 can be obtained by choosing Plot
Results from the Analyze menu, as shown in Figure A–30.

The joint sensitivities shown in Figure 6–11 are input by choosing Input
or Change Joint Variable Data from the Structure menu, as shown in Figure
A–31 for the ASP variables. The single variable ASP variations can then be
deleted by choosing Delete Variables from the Structure menu (Figure A–32).

Because new variables were added, it is necessary to choose Evaluate
Sensitivity before obtaining the first plot in Figure 6–12. Choose Save from
the File menu, and then change the input data for Alternative from 3 to 2  and
to 1 and evaluate again to obtain the second and third plots in Figure 6–12.
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Sensitivity name: Diagnostics, DiagStatic New  Alternative                                                
Model Name: E$C:\My Documents\Diagnostics.xls$npv$AA                                                             

VARIABLE                                                        

Mkt_10                                                             
Mkt_RF_fr_10                                                             
MS_gr_DSt                                                             
ASP_gr_DSt                                                             
COGS_gr_DSt                                                             
tech_succ_DStn                                                            
MS_pk_DStn                                                            
ASP_sy_DStn                                                            
ASP_gr_DStn                                                            
COGS_sy_DStn                                                            
COGS_gr_DStn                                                            
MS_gr_DRF                                                            
ASP_gr_DRF                                                            
COGS_gr_DRF                                                            
MS_pk_DRFp                                                            
ASP_sy_DRFp                                                            
ASP_gr_DRFp                                                            
COGS_sy_DRFp                                                            
COGS_gr_DRFp                                                            
Alternative                                                     

Excel options:                                                  
Open linked spreadsheets.                                    
Iterate w ith 100 maximum iterations and 0.001 maximum change.

DESCRIPTION                           

Total Market, 2010                    
RF Fraction of Market, 2010           
DiagStatic, Market Share growth rate  
DiagStatic, Price CAGR                
DiagStatic, COGS CAGR                 
DiagStatic New , Technical Success     
DiagStatic New , Market Share at Peak  
DiagStatic New , Price, start year     
DiagStatic New , Price CAGR            
DiagStatic New , COGS, start year      
DiagStatic New , COGS CAGR             
DiagRF, Market Share grow th rate      
DiagRF, Price CAGR                    
DiagRF, COGS CAGR                     
DiagRF Plus, Market share at Peak     
DiagRF Plus, Price, start year        
DiagRF Plus, Price CAGR               
DiagRF Plus, COGS, start year         
DiagRF Plus, COGS CAGR                
Strategy Alternative                  

BASE   

4500   
0.25   
–0.2   
–0.01  
0.02   
Yes    
0.2    
14000  
0      
4800   
0.02   
–0.1   
0      
0.02   
0.4    
19000  
0      
4800   
0.02   
3      

TYPE  

VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   

LOW    

4000   
0.2    
–0.25  
–0.05  
0      
No     
0.1    
12000  
–0.03  
4600   
0      
–0.2   
–0.04  
0      
0.25   
17000  
–0.03  
4600   
0      
3      

HIGH   

5000   
0.35   
–0.15  
0.01   
0.03   
Yes    
0.4    
15000  
0.01   
5200   
0.03   
–0.05  
0.01   
0.03   
0.45   
23000  
0.01   
5300   
0.03   
3      

STATUS 

NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    

Sensitivity name: Diagnostics, DiagStatic New  Alternative                                                
Model Name: E$C:\My Documents\Diagnostics.xls$npv$AA                                                             

VARIABLE                                                        

Mkt_10                                                             
Mkt_RF_fr_10                                                             
MS_gr_DSt                                                             
ASP_gr_DSt                                                             
COGS_gr_DSt                                                             
tech_succ_DStn                                                            
MS_pk_DStn                                                            
ASP_sy_DStn                                                            
ASP_gr_DStn                                                            
COGS_sy_DStn                                                            
COGS_gr_DStn                                                            
MS_gr_DRF                                                            
ASP_gr_DRF                                                            
COGS_gr_DRF                                                            
MS_pk_DRFp                                                            
ASP_sy_DRFp                                                            
ASP_gr_DRFp                                                            
COGS_sy_DRFp                                                            
COGS_gr_DRFp                                                            
Alternative                                                     

Excel options:                                                  
Open linked spreadsheets.                                    
Iterate w ith 100 maximum iterations and 0.001 maximum change.

DESCRIPTION                           

Total Market, 2010                    
RF Fraction of Market, 2010           
DiagStatic, Market Share growth rate  
DiagStatic, Price CAGR                
DiagStatic, COGS CAGR                 
DiagStatic New , Technical Success     
DiagStatic New , Market Share at Peak  
DiagStatic New , Price, start year     
DiagStatic New , Price CAGR            
DiagStatic New , COGS, start year      
DiagStatic New , COGS CAGR             
DiagRF, Market Share grow th rate      
DiagRF, Price CAGR                    
DiagRF, COGS CAGR                     
DiagRF Plus, Market share at Peak     
DiagRF Plus, Price, start year        
DiagRF Plus, Price CAGR               
DiagRF Plus, COGS, start year         
DiagRF Plus, COGS CAGR                
Strategy Alternative                  

BASE   

4500   
0.25   
–0.2   
–0.01  
0.02   
Yes    
0.2    
14000  
0      
4800   
0.02   
–0.1   
0      
0.02   
0.4    
19000  
0      
4800   
0.02   
3      

TYPE  

VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   
VAL   

LOW    

4000   
0.2    
–0.25  
–0.05  
0      
No     
0.1    
12000  
–0.03  
4600   
0      
–0.2   
–0.04  
0      
0.25   
17000  
–0.03  
4600   
0      
3      

HIGH   

5000   
0.35   
–0.15  
0.01   
0.03   
Yes    
0.4    
15000  
0.01   
5200   
0.03   
–0.05  
0.01   
0.03   
0.45   
23000  
0.01   
5300   
0.03   
3      

STATUS 

NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    
NEW    

Figure A–29

Sensitivity Data

Figure A–30

Plotting Sensitivity Results
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Figure A–31

Input of Joint Sensitivity Variable

DIAGNOSTICS (CHAPTER 6)

Figure A–32

Deleting Sensitivity Variables

Probabilistic Analysis: Choose Supertree from Start/Supertree 95. It is
possible to import directly data from Sensitivity to Supertree by choosing
Import Sensitivity Data from the Structure menu. Figure A–33 shows a
possible selection of variables to include in the tree from the saved sensitiv-
ity for DiagStatic New. For many problems, this simple procedure is sufficient
to construct the tree. However, the Diagnostics problem is a bit too compli-
cated to use this simple procedure.

The tree shown in Figure 6–13 is quite asymmetric, and poses a
challenge for the novice user of any tree program. Methods for analyzing
difficult (i.e., asymmetric) trees are presented below. The actual method
chosen depends on the nature of the problem, the skill of the facilitator, and
the capabilities of the audience that will see the tree.
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Figure A–33

Possible Import of Sensitivity Data into Supertree (not used in the analysis)

Figure A–34

Symmetric (Method 1) Tree for Diagnostics (not used in the analysis)
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Figure A–35

As Given (Method 2) Tree for Diagnostics (not used in the analysis)

1.  Symmetrize the tree if possible.  There are only 180 paths through
the Diagnostics tree in Figure 6–13. However, the simplest way to represent
it for the computer is to create a completely symmetric tree. On the positive
side, this is a quick and simple process. On the negative side, the number
of branches in the tree can become enormous, and the time required for the
spreadsheet calculations can become prohibitive.

To symmetrize the Diagnostics tree in the simplest fashion,  reproduce
all 7 chance nodes on each of the 3 decision branches. This tree has 4374
endpoints. Although this tree is beyond the capability of the student version
of Supertree, the spreadsheet is simple, and the tree took less than a minute
to evaluate on the author’s laptop computer. The structure of this completely
symmetric tree is shown in Figure A–34, where the tree has been broken into
two lines to fit on the page.

This tree is not used in the analysis in this document.
2. Construct the tree as given. Usually there is a natural way to draw

the tree. Although this may not be the most efficient way to enter the tree into
the computer, it is easy to communicate the input and output with everyone
involved.
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The problem with tree construction occurs at asymmetric nodes—
nodes for which the successors are not all the same. At the end of each
branch of an asymmetric node is a subtree associated with that branch. If
there are nodes that appear in more than one subtree, they must occur as
separate nodes in each subtree.

The tree given in Figure 6–13 could be entered into the computer using
the node numbering given in Figure A–35. The asymmetric nodes are the
first node (Alternative) and the second node (DiagStatic New Technical
Success). There are four subtrees, beginning at nodes 3, 7, 13, and 25. Two
nodes (Average Selling Price Growth Rate and RF Fraction of Market, 2010)
need to be added as separate nodes in each of these subtrees.

This tree is not used in the analysis in this document.
3. Move symmetric nodes as far left as possible without interchang-

ing chance and decision nodes. Because the order of chance nodes is
arbitrary, the facilitator can rearrange the tree to minimize the effects of
asymmetry. The general rule is to move the symmetric nodes as far left as
possible to remove them from the subtrees and thus avoid duplication.
Interchanging chance and decision nodes changes the value of the tree (as
in value of information calculations), and is left to the fourth method.

This method can be applied to the Diagnostics tree, with results shown
in Figure A–36. In this case, the change is not great. There are now only
three instances of the Average Selling Price Growth Rate node and of the RF
Fraction of Market, 2010, node—instead of the four in Figure A–35.

This is the tree used in the analysis in this document.
4. Move symmetric nodes as far left as possible. Sometimes a very

neat representation (from the computer’s point of view) can be obtained by
moving symmetric nodes as far left as possible, even if this interchanges
the order of chance and decision nodes. The negative aspect of this method
is that the analysis of tree results always involves a reordering of the tree
to get the decisions back into the position that they belong. This can be hard
to remember and even harder to explain.

Diagnostics’ tree can be reordered into the form shown in Figure A–37.
The two nodes, Average selling Price Growth Rate and RF Fraction of Market,
2010, are no longer duplicated. When tree analysis is performed, the
facilitator must remember to use a New order of nodes of 3 1 2… to put the
decision (node 3) at the beginning of the tree.

This tree is not used in the analysis in this document.
Analyzing the tree with Supertree.  For the remainder of this docu-

ment, we will use the tree shown in Figure A–36. The Supertree input for
this tree is shown in Figure A–38.

Node 2 uses a Supertree feature to vary the four ASP growth rates
simultaneously, with semicolons as separators between names and be-
tween outcomes. Nodes 12 and 22 are similarly defined

Node 9, the endpoint, needs the input from (depends on) nodes 1, 2, 3,
4, 5, and 6, but not the other nodes. The other endpoints, nodes 10, 19, and
29 have their dependency determined by the subtree they terminate.
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Figure A–36

Reduced (Method 3) Diagnostics Tree

What is going on with the probabilities for nodes 2, 12, and 22 and
for nodes 3, 13, and 23? If the tree were always going to be evaluated
in the given order, there would be no need to create dependencies
between these nodes—just enter the same probabilities (.25, .50, .25
in this case) for the nodes.

However, suppose we wanted to calculate the value of information
on Mkt_RF_fr_10 by moving node 3 in front of node 1 (New order of
nodes 2 1…)? Knowing that we are on, say, the top branch of node 3
means that we are also on the top branch of nodes 13 and 23 because
there is only one uncertainty appearing in three places in the tree.
The probabilistic dependency shown in Figure A–38 ties the three
nodes together.

 However, the facilitator should be careful about putting too many
dependent probabilities in the tree. Dependent probabilities can
create very large, memory-consuming data arrays in the computer.
One approach is to put the probabilistic dependence into the structure
only when it is needed for creating a new order of nodes involving the
repeated node—and changing these probabilities can be done without
evaluating the tree again.
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Figure A–37

Reduced (Method 4) Diagnostics Tree (not used in analysis)
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The output for the analysis in Chapter 6 uses techniques that have been
demonstrated before in this document. Figures 6–14 and 6–15 are the output
of the Plot Distribution option of the Analyze menu. Figure 6–16 can be
obtained by using the technique shown in Figures A–18 and A–19 to store the
four distributions to disk and then to recall them. Figure A–39 shows the
dialog box for selecting the distribution for the DiagStatic New alternative,
given Technical success—the nodes are reordered so that these are the first
two nodes in the tree, and then the distribution is obtained at the third node.

Value of Perfect Information and Perfect Control (Figure 6–21) can be
created by reordering the nodes and comparing the value with information
with the value without information. Note that putting node 2 in front of node
1 yields the correct value of information for the ASP growth rates because of
the dependency of the probabilities for nodes 2, 12, and 22.

The sensitivity to probability charts (Figures 6–22 through 6–28) are
obtained using the Sensitivity to Probability option in the Analyze menu.
Some care must be taken with the repeated nodes because the sensitivity
to probability option replaces the existing probabilities for the nodes. For
instance, you will obtain the correct graph for Figure 6–28 if you perform a
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STRUCTURE  

1D2 12 22  
2C3 3 3    

3C4 4 4    
4C5 10     
5C6 6 6    
6C9 9 9    
9E         

10E        

12C13 13 13

13C15 15 15
15C16 16 16
16C19 19 19
19E        

22C23 23 23

23C29 29 29
29E        

NAMES                    

Alternative              
ASP_gr_DSt;ASP_gr_DStn;A&
SP_gr_DRF;ASP_gr_DRFp    

Mkt_RF_fr_10             
tech_succ_DStn           
MS_pk_DStn               
ASP_sy_DStn              
E$c:\my documents\diagno&
stics.xls$npv$AA         
E$c:\my documents\diagno&
stics.xls$NPV$AA         
ASP_gr_DSt;ASP_gr_DStn;A&
SP_gr_DRF;ASP_gr_DRFp    

Mkt_RF_fr_10             
MS_pk_DRFp               
ASP_sy_DRFp              
E$c:\my documents\diagno&
stics.xls$NPV$AA         
ASP_gr_DSt;ASP_gr_DStn;A&
SP_gr_DRF;ASP_gr_DRFp    

Mkt_RF_fr_10             
E$c:\my documents\diagno&
stics.xls$NPV$AA         

OUTCOMES               

3 2 1                  
–.05;–.03;–.04;–.03 –.&
01;0;0;0 .01;.01;.01;.&
01                     
.2 .25 .35             
Yes No                 
.1 .2 .4               
12000 14000 15000      
Depends on 1 2 3 4 5 6 

Depends on 1 2 3 4     

–.05;–.03;–.04;–.03 –.&
01;0;0;0 .01;.01;.01;.&
01                     
.2 .25 .35             
.25 .40 .45            
17000 19000 23000      
Depends on 1 12 13 15 &
16                     
–.05;–.03;–.04;–.03 –.&
01;0;0;0 .01;.01;.01;.&
01                     
.2 .25 .35             
Depends on 1 22 23     

PROBABILITIES

.25 .50 .25  

.25 .50 .25  

.9 .1        

.25 .50 .25  

.25 .50 .25  

Depends on 2 

Depends on 3 
.25 .50 .25  
.25 .50 .25  

Depends on 2 

Depends on 3 

ASP_gr_DSt;ASP_gr_DStn;ASP_gr_DRF;ASP_gr_DRFp 
–.05;–.03;–.04;–.03                           
–.01;0;0;0                                    
.01;.01;.01;.01                               

PROBABILITY, NODE 12
1 0 0               
0 1 0               
0 0 1               

Mkt_RF_fr_10 
0.2          
0.25         
0.35         

PROBABILITY, NODE 13                                 
1 0 0                                                
0 1 0                                                
0 0 1                                                

ASP_gr_DSt;ASP_gr_DStn;ASP_gr_DRF;ASP_gr_DRFp 
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Figure A–38

Reduced (Method 3) Diagnostics Tree in Supertree
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Figure A–39

Storing the Distribution for DiagStatic New, Technical Success

sensitivity to the probability of node 3, but not if you perform the sensitivity
to node 13 or node 23—in the latter two cases, the sensitivity overwrites the
dependency linking the nodes.

The sensitivity to risk attitude in Figure 6–30 is obtained from the
Sensitivity to Risk Attitude in the Analyze menu.

Finally, a policy matrix such as shown in Figure 6–31 can be obtained
by displaying the tree up to the second decision point.

Portfolios (Chapter 7) ____________________________________________

Several methods of combining probabilistic results for a portfolio of busi-
nesses were shown in Figures 7–16 through 7–18. In all these methods, a
probabilistic analysis was done for each business, and then the probabilistic
results were combined.

In Figure 7–16, the probability distribution (conditional on strategy and
economic/environmental state) for each business was simplified into a two
or three-branch tree. In Figure 7–17, the simplified probability distributions
for the businesses were combined into a simplified Combined Business
Uncertainty. In Figure 7–18, moments and cumulants were used.

Supertree can provide the data required for these calculations. The List
Distribution Values in the Analyze menu provides a table of cumulative
probabilities, a table of moments, and a three branch tree that preserves the
first five moments of the probability distribution. The three branch tree
could be used for input into Figure 7–16. The moments could provide input
for Figure 7–18.

Figure A–40 shows this output for the Diagnostics business, one
business in Medequip’s portfolio. The data was requested at node 2, so that
we could specify the alternative (node 1, branch 1). The bottom display (Store
Distribution in the File menu) in Figure A–40 shows how the data can be
saved to a tab-delimited ASCII file (name to be supplied in the following
dialog box) for automated inclusion into a portfolio database.
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Figure A–40

Obtaining Values for Use in Portfolios

Value
9.212205042
10.04846475
10.89211506
12.0386219

14.57519136
16.03603992
17.70950807
18.8507464

Value
19.33216774
20.33042923
21.94148704
23.58718914

25.6533455
26.50644039
27.67263825
28.78891707

Value
29.35758788

32.3996861
36.24024298
44.10030504
48.33203976
49.95458561
53.16548598

Percentile
0.010
0.020
0.050
0.100
0.150
0.200
0.250
0.300

Percentile
0.350
0.400
0.450
0.500
0.550
0.600
0.650
0.700

Percentile
0.750
0.800
0.850
0.900
0.950
0.980
0.990

Expected value (mean): 25.18370929
Variance: 113.7297105             

First 
Second
Third 
Fourth
Fifth 

Moment            
25.18370929       
747.9489243       
25509.26191       
968989.599        
39838411.62       

Central Moment 
0              
113.7297105    
944.8617006    
38797.69288    
665923.0623    

Cumulant          
25.18370929       
113.7297105       
944.8617006       
–5.648273228      
–408665.4145      

Three branch node that matches f irst f ive moments:
Probability  
0.3525398741 
0.5169977303 
0.1304623956 

Value       
13.76561683 
27.31932097 
47.57503883 

Value
9.212205042
10.04846475
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12.0386219
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18.8507464
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20.33042923
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Percentile
0.010
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0.100
0.150
0.200
0.250
0.300

Percentile
0.350
0.400
0.450
0.500
0.550
0.600
0.650
0.700

Percentile
0.750
0.800
0.850
0.900
0.950
0.980
0.990

Expected value (mean): 25.18370929
Variance: 113.7297105             

First 
Second
Third 
Fourth
Fifth 

Moment            
25.18370929       
747.9489243       
25509.26191       
968989.599        
39838411.62       

Central Moment 
0              
113.7297105    
944.8617006    
38797.69288    
665923.0623    

Cumulant          
25.18370929       
113.7297105       
944.8617006       
–5.648273228      
–408665.4145      

Three branch node that matches f irst f ive moments:
Probability  
0.3525398741 
0.5169977303 
0.1304623956 

Value       
13.76561683 
27.31932097 
47.57503883 

PORTFOLIOS (CHAPTER 7)


